Quant

QA40x User Manual

Revision 1.20
February 2022



QA402 User Manual

Safety Notice

v This device is not designed for working on potentially dangerous voltages.

This device is not designed for working on high energy circuits.

The maximum DC input voltage is +/- 50V into the device inputs.

The maximum AC input voltage is +/- 40Vrms into the device inputs.

The combined AC + DC must not exceed +/- 56V peak.

Do not apply any voltage to the outputs.

If the above are not clear, seek guidance from a person trained in electrical safety.
See additional safety notices throughout this document.

CAUORRRR

Limited Warranty

This product has a limited warranty of 6 months from the time of purchase. During this time, a device failure
that occurs under normal operating conditions will be replaced or repaired for free, not including shipping.
Generally, you will be responsible for shipping to us, and we will be responsible for shipping it back to you.
Devices that have suffered a failure due to operation in excess of specified parameters can usually be repaired
for a nominal fee. The contents of this document are provided “as-is” and may be changed or updated without
notice. The specifications on a particular product may also be changed at any time and without notice as we
seek to improve a product or improve availability of a product. The limit of our warranty will not exceed the
value of the product purchased under any conditions.

Legal

This document and the associated computer codes, hardware design and hardware configuration files are
copyright © 2011 - 2021 by QuantAsylum USA LLC. All rights are reserved. You may share the associated
documents in PDF format freely. The EXE programs and provided APIs codes are use only with QuantAsylum
products. The hardware and software designs are protected and the property of QuantAsylum USA LLC.




QA402 User Manual

Contents
.............................................................................................................................................................................. 1
SATEEY N OTICE. . e cuteeiiereee ettt ettt ettt e et e e e et e e estae e e eetbaeeeeeabaeeeabbeeeeasbaeeeeasbaeeeasbaeeeanssaeesansaeeeenstaeeeeasbanesasreeens 2
R a1 E=Ye VAT T - [ o] Y USSR 2
=Y = | OO U PP P PP UPPUPPTOPPRTR 2
ONlINE DOCUMEBNTATION. ...ei ittt ettt ettt e et e st e e b e e s aae e e ameeesmbeeeabeeeabeeeneeeanbeeanseesnbeeenreeennneas 5
Ta TR a1 2o O PRSP UUPPPPRUPPTOPPRPRI 5
IMPOrtant ThINGS TO KNOW ....uuiiiiiiiiiiiiiieee ettt erctre e e e e e e et e e e e e e e e s aataaeeeeeesanssaaeeeeeesasnsssaaeeeesesnnnsreneees 5
Y ToTe L=l N U 001 o 1T T TP PP UPRPPTRO 5
GIOUNG REFEIBNCE. .. eeiiiieetee ettt et e s e sttt s aee e sa et e sabe e s beeeaeeeateessbeesateesnseesnsteeanseesnteeensaeenssens 5
2N TR T oY UL Vo] == PR 5
BINC OULPUL VOIAEES .veeiteeeiieiiie ettt ettt sttt s e st e e stee e s et e e s ste e s sbeesateesstteessteesnsaesntaesnseessseenaseesnseesnses 5
QA40x Output Voltage Offsets, ClICk @aNd POPS ...ccceieeiiiieieccitee ettt ee e ee e e tee e s e e e e snae e e ennes 6
QAAOX ANIYZEE FEATUIES .. .uteeiiieeieeitieeite ettt ste e st e s bt e ettt e sate e s teessbeeebeeeateeabeesabeesnbeesaseeerseeensseeanseesntaesnsaesnssens 6
F AN 1Y gl S o o A - Y =Y S 6
LE DS ettt ettt ettt et ettt et ettt e te ettt e te e et e et e teeate e te e teeateenEeeateeate e teeate e teenteenteenteenteenteenteenteenteenteenteenee 6
(o 1A 1 (o] W6l ] oY 1=t o] co TP PP PP PP PPPPPPPPPRRNY 7
2N (O T oY UL £ o [ 10 11 £ SRP 7
Understanding Differential MEasUrEMENTS. ......ccccveiiiiiiiee e e e cciee e st e e eetee e e sree e estreeessbreeeesaraeeeennraeessnsreeens 8
ol oY= YUY ' = SR 8
Electrical Characteristics Of the CONNECLONS ........eiiuiiiieiee ettt sttt et et e 8
BIN G N DULS . s 8
BINC OUT PULS . s 9
SOTEWAIE INSTAIIATION .c..eeeteete ettt b e b e s bt e s bt e bt e s bt e sbeesbeesbeesbeesbeesaeesanesanennnes 9
WWINAOWS VEBISION ...ttt ettt ettt ettt ettt e et e b et e at e e s ab e e eabeeeabeeeneeeaaseeeabeeebee e nbeeanbeesabeeaaneeennbeesabeeeanes 9
USB DFIVELS ettt ettt s b et e e s bbbt e s s bbbt e s s ab bt e s b b e e e s b s e e s s b et e s s b st e s e naeee s 9
(611 o] 4 o o FAUU U O T OO ST O T T PP PP PPPT P PP POPTOPPRI 9
PIUSZING IN YOUTI HANAWAIE.....eeie ettt ccteee ettt e et e e e etb e e e s baee e e abaee e e tbaeeesasbeseeastaeeeesraeesassaeesansaeseensranenanes 10
Button and Control Panel OPEIation .........cccveeeiiiieeeeeiieeecccireeeeceteeeeeeteeeesetreeeesstreeeesbaeeeessraeesessesesssresessnraneeanes 10
QAAOX BASIC CONEIOIS ... .ttt ettt ettt ettt e st e et e e bt e e bt e e sabeeeabeeebeeenbeasnteesabeesbeeeaneeesareans 11
MEASUrEMENT DISPIAY AT ...vveiieiieee ettt e ccteee ettt e e et e e eeetbeeeestaeeeesabaeeesatbaeeeasseseeastaeeeeasraeesassesessnsaesenasraneennes 12
TrACE DISPIAY ATCQ ..eeeiieeiiee et ettt e e et e e st e e e st e e e e st eeeeeetaeeeaaseeeaaataeeeasntaeeeansseeeeanseeeeansseeeeanssaeeannseesesansenasanns 14
1 T OO PP P PR PUPOPPTOPRPN 14




QA402 User Manual

SYSEEM ANNUNCIATONS ...ttt e e e e e e s s b e et e e e e e s nb bbb e e e e e e s e nnneraeeeesessannnenneeas 14
(00 a1 o] I € oYU o1 SRR 16
DiISPIAY OPLIONS ..ttt ettt ettt ettt et e ettt e at e e st e e st e e e bee e bee e ateeeabe e e tee e bae e haeeenbeeeabeeebaeenbaeenareesbeeea 16
E LY L 1 =£ 17
ACH (ACQUISTEION) SETEINES . .uvveeeeirieeeeeteeeeectee e eeetree e estee e e esbee e eeetbeeeesetbeeeeaabaeeeessbaeeeessbeeeeasseeeeasbaeesensbasesansseeens 19
W IGITINEG ettt ettt e ettt et e e e s a b e e st e e e bee e ate e sabeeeabeeeabbeebee e nbeesbae e beeesnbeenabeenns 20
AVAV g T oL Y7o V- PRSP 21
VT U =T 4 =T o TP 21
LCT= 1= o PO 23
Y= €=t o T=T = o] o H PP 24
IVIUIEIEONE <.ttt b e b e b e s bt s b e s bt e s he e s bt e sab e e aeeea e e s ateeateeatesaeesateembeenbesnbeenteeane 25
WHITE NOISE ...ttt et et r e et r e e r e e n e e r e e r e e r e en e e r e e reeneenreenreenneenneens 27
] o T @ o1 o F TSP POUPOUPRR 27
U1 or= L= VYo U SO R 29
LT ] o] o YU UUT 30
RUN/SEOP CONTEXE IMENU ..ottt ettt ettt e e et e st e s taesaaesabesaaeeabesasessbesasesasesabesabesnsesnsesnsesnsesnsenans 31
LOTT 1o 3PP PP PR 32
ORI IEBIMS .ttt et ettt ettt st e et e e abe e aeesa b e e abeeateeabeeabeeabeeateeateeabeeabeeabeeabeenbeenreenne 34
R Yo ]t =3RS 34
(@foT 0] 0 =Yoo W N1 T @] o) o] o YRR SRR 35
AUTOMATEA TSES . .eeiuieiiiete ettt ettt ettt et et et r e et e r e e r e e r e e r e e r e e r e e r e e n e e s e e reereenreenreenreens 35
VISUBNIZEIS .t r e st r e s r s r e 35
ReMOte CONLIOl AN APIS......coiiiiiiiieie e s sb e s e sa e r e s ne e 35




QA402 User Manual

Online Documentation

This manual focuses primarily on the functionality of the hardware and the software. The application,
measurement techniques and tradeoffs are a substantial topic especially when the experience level of users is
considered. Additional sources of information can be found at the Github Wiki for the QA40x, and the
QuantAsylum Forum.

In the Box

The box contains a QA402 Audio Analyzer. We do not ship cables with our products. The software for the
products may be downloaded from GitHub. The link for QA40x downloads is located here.

See the Github QA40x Getting Started Wiki for ideas on accessories.

Important Things to Know

This section covers some important details about the analyzer.

Model Number

In this document, the phrase “QA40x hardware” refers to the QA403 and QA402 hardware. The phrase “QA40x
software” refers to the application used to interface with the QA40x hardware. The family of hardware
products (QA402 and QA403 hardware) use the same QA40x software.

Ground Reference

There are two grounds to consider on the QA40x. The USB connection shares a ground with the PC, which in
turn shares a ground with the power distribution in your office. The audio side of the QA40x analyzer is isolated
from the USB ground: it is floating. When you connect the QA40x hardware to a device-under-test (DUT) to
make a measurement, you will need to establish a common reference point for the measurements. The DUT
will have its own ground (which may be similar to the PC ground). The isolation provided by the QA402 ensures
noise related to ground currents is eliminated.

If your DUT is also floating (which is common if the DUT is powered from a “brick”-style wall adaptor, then you
can reduce powerline hum in your measurements by connecting the floating ground to an earth ground.

BNC Input Voltages

The inputs on the QA40x hardware are designed for AC inputs, with some DC present. The DC will be blocked
by the input capacitor and cannot be measured. DO NOT EXCEED THE SPECIFIED LIMITS, OR YOU WILL DAMAGE
THE QA40x AND/OR MIGHT INJURE YOURSELF.

BNC QOutput Voltages

The BNC outputs are DC coupled. They cannot withstand inadvertent connections to DC voltages where more
than 10 mA of current might flow. Extended shorting of the outputs will result in an increase in temperature
of the output stage, which can cause a permanent shift in performance.
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QA40x Output Voltage Offsets, Click and Pops

The QA40x outputs may exhibited DC offsets up to +/- 2 mV or so. Additionally, operations such as sample rate
changes may generate momentary clicks or pops. If you are working on very high gain stages or driving a power
amp that is driving a speaker, be aware that these offsets, clicks and pops might impact your DUT.

QA40x Analyzer Features

The QA402 is our third-generation analyzer, and the QA403 is our fourth-generation analyzer. They build on
the QA401 by adding additional input and output handling in addition to a front-panel expansion port.

The QA402 and QA403 features:

e Stereo Differential Left + Right Inputs

e Stereo Differential Left + Right Outputs

e 24-bit ADC and DAC for QA402, and 32-bit ADC and DAC for QA403

e  Fully Isolated from the PC

e 8 Input Gain Stages, from 0 dBV to +42 dBV full scale (the maximum input is +32 dBV)

e 4 Output Gain Stages, with a maximum output level of +8 dBV (single ended) or +14 dBV balanced.

We hope you enjoy your purchase. Our forum is a great place to learn more about how to use your new
analyzer, or you may contact us at support@QuantAsylum.com. We welcome all questions, no matter how
simple. Analyzers are complex products, and your questions help us improve our products.

Analyzer Front Panel
The front panel of the QA402 analyzer is shown below. The QA403 is similar.

- ™

> Quant S (;
L

QA402 Audio Analyzer

Link e Expansion
Run (D ~ Connector -
aen® el | 2
© /N cati \_ /AN 22 dBV Max Y,

A

—J

From left to right, the following elements are described below:

LEDs
There are 3 LEDs that glow green when active.

Link LED: This indicates the QA402 is “talking” to the desktop application software.

Run LED: This indicates the QA402 is running an acquisition.
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Atten LED: This indicates the QA40x input attenuator is active. If you are going to connect the QA40x hardware
to large signal, it is best to pick one of the higher input ranges that enable the input attenuator as you attempt
to learn the characteristics of the signal you are measuring. This is especially true if you are measuring
equipment that is being repaired that might have potentially unexpected outputs behavior. The LED allows you
to readily see if the input attenuator is active, ensuring the QA402 can protect itself from unexpected inputs.

Expansion Connector

The QA403 and QA402 have slightly different front-panel connector pinouts. The expansion connector for the
QA402 is a 2x8 pin male connector with a 1.27 mm pitch. As you face the connector and front-panel, the
connector pin out appears as follows:

QA402 Front Panel
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QA402 Front Panel Expansion 10 (facing panel):

16 conductors (2x8)/1.27mm pitch

Male Socket on QA402: CNCTech 3220-16-0200-00
Mating Connector: 3230-16-0102-00

Lower Row all GND (pins 1-8)

The front-panel connector currently supports driving Generator 1 and/or 2 DAC output sines at 16- or 32-bit
widths at 48 kSPS. 12C, ADC input, and sample rates other than 48 kSPS are not currently supported, but may
be added in the future. More information and schematics for use with the front panel expansion connector
can be found on the QA40x.

BNC Inputs and Outputs

The QA40x hardware has 4 outputs, or both left and right differential pairs. The + and — signals are always
complementary. That is, when the L+ signal is rising, the L- signal is falling. Viewed on a scope, the + and —
signals are always moving in equal but opposite directions.

The left and right outputs largely work in unison, but there are certain modes (for example, muting or external
waveforms from an API) where the left and right outputs can work independently.

Most consumer gear will take a single-ended input and output signal. Pro-audio will often take a differential
signal. Differential signals are commonly used in noisy environments because interfering signals that appear
on both inputs simultaneously are “cancelled” or at least greatly attenuated. However, for much of your audio
work, you may prefer to use the device in single-ended mode especially if you are working on line-level
consumer audio type equipment. If you wish to use the inputs single ended, then you can use a BNC terminator
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on the L- input, and treat the L+ input as a single ended input. If you do not use the input terminator, then you
will see some thermal noise from the unused input resistor, which will raise the overall noise floor.

Understanding Differential Measurements

Differential measurements can create confusion even among very experienced engineers. Some examples will
help highlight the differences. If you set the generator to 0 dBV and connect an Output+ to an Input+ and
ground the Input- via BNC terminator, then the measured input will be reported as 0 dBV. With the output set
to 0 dBV, each output will measure 1Vrms on a DVM relative to ground (the BNC outer conductor). A
differential measurement on a DVM (from Out+ to Out-) will measure as 2Vrms. This is because the Out+ and
Out- are 180 degrees out of phase with each other. If you set the output to -10 dBV and connect both the Out+
and Out- connectors to the In+ and In- connectors, then the QA402 measurement will show a peak of -4 dBV.
This is because you are driving the inputs differentially. This can be very confusing to first-time users: You are
driving the inputs at 316 mVrms (-10 dBV), and yet the QA402 is reporting -4 dBV. But this is precisely the same
measurement reported by the DVM when you placed the DVM across the outputs. Keep in mind the QA402
inputs have no idea if you are driving a single input with 1Vrms and grounding the other input OR if you are
driving both inputs with 0.5Vrms. In both cases, you are hitting the ADC with the same differential voltage.
That is, the differential input of the ADC is seeing 0.5Vrms on each input in both cases.

Rear Panel Summary

The rear panel has a single USB connector. This is designed for high speed (480Mbps) USB connections. The
device consumes between 700 and 900 mA during normal operation. The device is not sensitive to USB voltage
variations, but it can be sensitive to USB voltages that fall below 4.6V as measured inside the QA402. For this
reason, use USB cables that are short and have 24 AWG power conductors. You can often read the wire gauge
directly off the side of the USB cable. Note that some computers may employ very strict current sensing on the
USB current flowing out of the USB port. When the current exceeds 500 mA, the PC hardware might signal a
fault. If you suspect your PC has strict limits on the power, then you can use a USB Y connector. These are
connectors that plug into 2 USB ports and allow USB hardware to pull up to 1000 mA. One of the USB ports has
no data connection. It just takes power from the second port. Alternately, most low-cost USB hubs that are
self-powered do no sensing or limiting at all.

Electrical Characteristics of the Connectors

BNC Inputs

The 4 audio signal inputs pass through a 4.7uF series capacitor, followed a series 470 ohm resistor, and followed
by a shunt resistor divider with a total impedance of 100K ohms. The corner frequency of this input network is
about 0.4 Hz. The input DC blocking capacitor is an aluminum electrolytic non-polarized, with a 50V rating.
Keep in mind that aluminum electrolytic capacitors have limited lifetimes that is dictated by their stress and
temperature. These lifetime specifications are usually at high ripple currents and high temperatures, which
won’t be seen by the analyzer. But it’s a good idea to not leave large signals or high DC values connected to
the analyzer overnight if you are not actively measuring something.
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Excessive input voltages can also stress the 470 ohm input resistor. The purpose of this resistor is to limit
current in fault conditions, and it’s a special composition resistor that can cope with very high pulse currents.
But under extreme conditions the resistor might open to protect the inputs.

BNC Outputs

The output op-amps have a 100-ohm series R in an 0805 form factor. If the output is accidentally connected to
a voltage more than few volts in magnitude, the 100-ohm resistor could act as a fuse and open or the output
op-amps could be damaged. Do not short the output stages. Do not drive the output stages into loads that are
below 100 ohms or so, especially at higher output levels.

Software Installation

The QA40x application has an installer, but it can also run from a USB key without any installation (although
certain support files such as this help document won’t be present when select Help->Open Users Manual PDF).

Windows Version
The QA40x application was developed on Windows 10, although it might run on previous versions of Windows.

USB Drivers

On Windows, you do not need to install drivers. The hardware uses special USB descriptors to tell Windows to
use a WinUSB driver. The first time you plug the hardware in, Windows should automatically load the drivers.
When successfully installed, you should see the QA402 (or QA403) appear in the USB Devices section in
Hardware Manager

— — e e e

i3 System devices
i LIniversal Serial Bus controllers

W i Universal Senal Bus devices

§ QA402 Audic Analyzer

Calibration

The QA40x hardware was calibrated at the factory and should deliver +/- 2% accuracy across all input and
output ranges. If you measure the QA40x outputs with your DVM, keep in mind that DVMs are generally
specified at 50 or 60 Hz and their accuracy at 1 kHz and higher is degrading quickly. A better solution for
confirming accuracy is a benchtop DVM. These will typically have +/-0.05% accuracy for signals up to 20 kHz or
so.

When measuring the QA40x outputs, remember the QA40x hardware uses bursted outputs for measurements.
See the description of the IDLE button for times when you need a non-bursted stimulus. This can be useful if
you are checking DUT gains manually with a DVM.
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Plugging in your Hardware

The QA40x application requires you to specify the hardware model you are connecting. In the lower left of the
application, you will see a message indicating which hardware is expected. You can change that in the File->
Device menu option.

RUN/STOP

LIIRSTIRS

| Connect the QA402, See File-»Device to change. |
g

When you have correctly set your device and plugged the device in, you will see a status confirmation as shown
in the lower left corner:

HRSTRS

[ Connected | Idle || REST server ready || Firmware: 49 ||| USB

After the device has been connected, you can begin making a measurement by pressing the RUN button in the
Run/Stop control group.

Button and Control Panel Operation

The buttons in the control panel on the left side of the screen are large enough to be easily pressed with a
finger if you are using a touch screen. The control panel can be scrolled up and down with the mouse wheel. If
you are using a trackpad, there is usually a trackpad shortcut for mouse wheel operation. Usually this is a two-

finger drag across the trackpad.

10
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Alternately, you can use the up/down arrows to scroll the panel normally, or page up/down to scroll the panel
more quickly.

The buttons will illuminate when the mouse passes over the button unless the button is disabled. This gives
you a chance to better read the text when is normally dim when the button is in the un-pressed state. When
the button in pressed, the text and the perimeter will illuminate.

Some buttons are part of groups, and groups might only allow a single button to be pressed at a time. The
sample rate buttons are examples. When you press a button that is part of a group that only permits a single
selection, the button that is currently illuminated will momentarily flash to signify it is turning off in response
to your request to change modes.

QA40x Basic Controls

The QA402 and QA403 application, also known as the QA40x application, is shown below:

QA4Dx Analyzer 1.130 - [m] X
ty:

Quant Asylum Sys:FFT =X |L: THD dB =X |L: THD+NdB = X | Sys:Gen1 = X | Sys:Gen2 Bl
ALDIO ANALYZER 16k -39.99 dB -38.22dB S 0004y
| i i

Y OPTIONS

Atten

Fr

WINDOWING  ®

HANN

MEASLIREMENTS

GENERATORS

1000
Frequency (Hz)

Firmware: 48 [|[USB Voltage: 2658V | USE Current: 0.781A | 1SO Current: 05194 | 25.0C | Calibration: Default |

[Connected | Streaming | Acg: 38 [REST server ready |

On the left side of the application is the CONTROL region. On the right side of the application is the SPECTRUM
or GRAPH region.

In the control region, you can use the mouse wheel to scroll the control set up and down. On a laptop, this can
usually be done by using two fingers on the track pad (check with your laptop vendor to see how they
recommend emulating a mouse wheel if the two finger technique doesn’t work). Alternately, the Page Up and
Page Down buttons will scroll the control region, as will the up and down arrow keys.

11
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Measurement Display Area

At the top of the trace display is the measurement display area. Measurements can be added by clicking in this
region:

0

1000
Frequency (Hz)

Clicking will bring up the Add Measurement dialog box:

12
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FterMeasurements: | Clear Fiter

[ L: Gain Db [ R:Gain Db ~

[ L N-D dBV [ R:N-DdBY

[ L: Peak dBV [ R: Peak dBV

[] L: Peak Vims [] R: Peak Vims

[ L: Pur Wats [ R: Pur Watts

[ L: RMS d&r [ R: RMS dBr

[ L: RMS dBu [ R: RMS dBu

[ L: RMS dBv [ R: RMS dBV

[ L:SNRdB [ R:SNRdB

CLTHD % CIR:THD%

v

[ SysAverages [ SystFFT [ SysGent

[ SysGen2 O] SysGenFR [ SysGenMT

[ SysGenWN [ Sys:Resolution

Uncheck Al Uncheck All Left Uncheck Al Right
Display Title on Graph Ca
oK Cancel

You can filter on measurements by entering text in the Filter Measurements dialog. For example, if you enter

“thd” (case insensitive) the test choices will collapse to the following:

Add Measurement

CJLTHD %
[] L: THD dB
[ L THD+N %

[ L: THD+N dB

Uncheck All

Digplay Title on Graph:

Fitter Measurements: Clear Filter

[JR:THD % -
[] R: THD dB
[1 R: THD+N %
[1 R: THD+N dB
w
Uncheck All Left Uncheck All Right
Clear
oK Cancel

13
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If you wish to add a title to your graph, that can also be done in the Add Measurement dialog in the text box
at the bottom of the dialog. You can specify up to four lines of 80 characters each.

Trace Display Area

The graph display area can have a few areas of added information, in addition to the measurement traces.
These are highlighted below by the red boxes. On the left are the system annunciators. On the right are the
markers.

y-Compensation

100 1000 10000
Frequency (Hz)

Markers

Markers can be added to the plot by right clicking on a peak. The markers are always sorted from highest
amplitude, and the tabular display will convey both absolute value and relative value referenced to marker 0
(the highest peak).

Markers can be removed by right clicking on the graph and selecting “Remove all Markers” or by pressing the
D key.

When placing markers on tones that are close in frequency to other tones, it can be helpful to click and drag a
zoom window, place the marker, and then zoom back out.

System Annunciators
System annunciators are short messages to convey special modes of operation, and they will appear in the
upper left corner of the graph. The complete list of annunciators that may be displayed are below:

14
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ADC Overflow: Indicates the ADC had packets, but the USB didn’t take them in time and so may have been
lost. Sometimes, this message can be a bit pessimistic and what was flagged as an error might not have been
an error. When this message appears, either re-acquire the signal or carefully inspect the time-domain signal
for a dropout.

Atten: Indicates the front-end attenuator is active.

DAC Underflow: Indicates the DAC needed packets, but the USB hadn’t delivered them yet. Sometimes, this
message can be a bit pessimistic and what was flagged as an error might not have been an error. When this
message appears, either re-acquire the signal or carefully inspect the time-domain signal for a dropout.

FFT Too Small: Indicates the FFT might be too small for the displayed activity (usually this will be shown in
Frequency Response (FR) mode).

FP 12S Clip: Indicates the signal being sent to the front panel is clipping.

FR Gain: Indicates the FR mode graph is showing gain instead of absolute level.
FR Ref R: Indicates the FR mode graph is using the right channel for the reference.
Input Gain: Indicates the user-specified input gain.

Latency Compensation: Indicates the user-specified latency compensation. Often, when working with
Bluetooth or other DSP-based equipment the latency compensation will need to be increased to ensure the
signal is properly captured (see Edit->Settings).

Mirror: Indicates Generator 1 settings are being mirrored to the PC’s primary audio device.
Mute L: Indicates the left channel is muted.

Mute R: Indicates the right channel is muted.

No Channels Selected: Indicates no data has been selected for display. Select L, R or both.

Caution! Input Range Test Mode: Indicates the input level is unclipped and can display levels in excess of safe
operation. This also indicates the front-end attenuator is always active. This mode is used for testing by
authorized personnel that need to verify measurement accuracy at higher voltages.

Output Gain: Indicates the user-specified output gain.
Output Displayed: Indicates the output traces are being displayed, rather than the input traces.

Range: Indicates that during the last acquisition and overload was encountered and the attenuator was
engaged.

Pause: Indicates a non-zero user-specified pause time has been entered (see Edit->Settings). This pause will
occur between acquisitions and can be helpful in dealing with higher latency systems OR in systems where you
want to careful limit the average power delivered to a load (by making measurements less frequently).

A Weighting: Indicates A-weighting has been applied to the displayed trace.

User Weighting: Indicates the user-specified weighting has been applied to the trace. This will also include the
file name of the weighting file.

15
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Control Groups

The control panel on the left side has several groups of controls. Inside each group, there are two control types.
We can see an example of this in the Axis Settings control group. On the left side you can see four buttons, and
on the right side you can see a pair of up/down controls.

The up/down controls allow you to increase or decrease a quantity. They are sized for fingers on a touch screen,
but you can also click them with a mouse.

The buttons on the left side are also sized for a finger on a touch screen. Note some buttons have an underline
beneath the button label. That indicates a “context menu” is available for that button. To active a context
menu, you can either:

1) Click (or touch) and hold. After 1 second, the menu will open. This is useful if you are using a finger on
a touch screen.
2) Mouse right click. The menu will immediately open.

A sample control “stack” is shown below. The heavy underline indicates the dBV and X LOG button both have
a context menu available.

AXIS SETTINGS

Display Options

The Display Options control group is shown below:

DISPLAY OPTIONS

INPUT LEFT

The Time and Frequency buttons will toggle between the time and frequency domains. If you press the time
button, you’ll see a trace that shows input and output waveform, with volts as the Y axis and time for the X

axis.

The Input and Output buttons allows you to toggle between displaying what is being output to the DAC or to
see what is being captured by the ADC. This is useful for letting you see the impact the DUT has on the
waveforms.

The Left and Right buttons allow you to pick which traces will be displayed. Left is always shown in Yellow and
Right is always shown in Red.
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AXxis Settings

The Axis Settings control group is shown below:

AXIS SETTINGS

The dBV button will display the frequency domain in the absolute units of dBV, while the dBr button will display

the frequency domain relative to a signal you specify.

The context menu for the dBV button is shown below:

dBV Opticns

't A
@ dBv
) dBu

Extemal Gain

(® Vims
() Watts

Mote: Selecting "RtHz is
appropriate when analyzing
noise. However, the level of
signal peaks will be incomect
when ‘BtHz'is enabled.

Input Gain (dB)

Output Gain (dg) 000

Peak Display Format

Load Impedance

Cancel

In this dialog, you can specify the units for the Y axis. Normally, dBV is used. But you can also specify dBu. You
can also specify if you have any external gains being used. For example, if you have a mic pre-amp of 20 dB,
then you could specify 20 dB of input gain and then the display would show you an input-referred noise
measurement (for example).

The dBr context menu is shown below:
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Relative dB Settings
Quick Settings
Set Display Peak to 0 dB
Set 1 KHz Levelto 0 dB

Settings
Specify 0 dBY Paint in dBr

=

Specify Level of Display Peak in dBr

E——

Puis Title: |

if "Axis Title'is is specified, that will be shown on
the ¥ Axis. Leave blank to use default ‘dBr'

| Cancel I

When using the dBr display option, you need to specify your reference amplitude. This dialog allows you to
quickly specify the reference using the display peak or the left measured at 1 kHz. Or you can specify the dBV
value that should map to 0 dB. Or you could specify the level in dBr. This is useful if, for example, you know

that a mic should generated a certain output at a given sound pressure level.

When using the dBr setting, you can also override the Y-Axis units and specify your own units (for example,

dBSPL).

The “X LIN” button enables a linear display on the X axis. In this mode, all frequencies are equally spaced. The
context menu for X LIN is as follows, and it allows you specify the start and stop frequencies.
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Linear Axis Settings

Start Freq |D-DE' Hz |

Stop Freq |20.0 KHz |

Center Freq | |

Span | |

IUse Center and Span Data

Cancel

The “X Log” button is similar, except it selects a logarithmic X axis. The dialog box options are similar.

Acq (Acquisition) Settings

The Acquisition Settings control group allows to set FFT sizes and averaging.

ACO SETTINGS

Al [A]
Lv] [v]

FFT  AVERAGE —

Larger FFTs will take more time to acquire. Generally, it’s good to work with an 8k to 32k FFT for most work.
Some measurements, such as THD+N will show little benefit at higher FFT settings. But other measurements,
such as THD, will indeed show marked improvements at larger FFT sizes as the noise floor is reduced and
harmonics are revealed.

Each click of the averaging button will increase or decrease the average count by one. If you click while pressing
the CTRL button, the count will change by 5 counts.

When averaging, you might wish to re-start the averaging process for some reason. That can be done with the
Reset button. When you change input levels or other certain other parameters, the averaging will be re-started.

When you activate averaging, a measurement tile will automatically be added showing the averaging status. In
the example below, we can see averaging has been set to 10, and we’ve collected 3 of the 10 waveforms so
far. As you reach the specified numbers, the display will show 10/10 for all subsequent measurements. This
indicates the averaging buffer is full and what you are seeing is the full averaging taking place.

19



QA402 User Manual

Sys:FFT £ X | Sys:Averag... = X

64k

Weighting

The Weighting controls allow to you apply standard “A Weighting”, or a custom User-weighting function. The
latter can be useful for “flattening” an RIAA response curve, notching out undesired frequencies or

compensating for known DUT deficiencies.

WEIGHTING

The context menu for the USER1 weighting is shown below:

Load User Weighting Function

Iser Weighting File:
(Mo file specified)

Select File

The userweighting file specifies attenuations that will be applied to
the measured signal before display. The specified file must contain
ordered points representing a frequency and an amplitude
adjustment separated by a comma. The frequency must be
monotanic. Adjustments will not be made outside of the specified
range. A sample file might appear as follows:

0.-20
1000, 0
10000, -3
20000, -5

Phase information after the magnitude information will be ignored.

The calibration value will be interpolated and subtracted from the
displayed value. Thus, if your mic has -5 dB of gain at 20 KHz, the

Cancel

measured value at 20 KHz will be boosted by 5 dB when displayed.
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Windowing

The Windowing controls allow to select the window type. You can click on the “?” mark for some hints on the
different types of windows. In general, if you are using the DAC on the QA40x as the stimulus, then RECT or
HANN windowing is preferred. If you are using an external generator, then HANN is probably preferred. If
amplitude accuracy to 0.02 dB or so key, then FLAT TOP is preferred.

WINDOWING ©

HANM

Measurements

You can quickly select the types of measurements you’d like to make from this control group. The buttons are
“one-shot” in that they don’t stay lit. If you press GAIN and you don’t currently have a measurement tile, then
a GAIN measurement will be added. If you already have a GAIN measurement tile, then it will be removed.
Note all measurements make sense in all modes of operation. For example, each of the measurements below
are ambiguous during a frequency response measurement.

MEASUREMENTS

The context menu for RMS measurements appears as below. Here is where you specify the frequency range
over which the RMS is calculated.

RMS Measurement Options

Measurement Start Freq: 20.0 Hz
Measurement Stop Frequency: 20.0kHz

Cancel
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For THD and THD+N, the context menu is as follows. The Measurement Start and Stop frequency is the same
as the RMS setting. That is, you set a measurement start and stop frequency globally, and that is used for all
measurements that need a measurement start and stop specified. In the case of THD+N, the noise is computed
by measuring the spectrum from the start to stop frequency.

You can specify your preference for THD and THD+N measurements. If you select “dB”, then when you add a
THD measurement it will default to dB. Otherwise, it will default to percent.

The fundamental selection is where you tell the application how to determinate the primary frequency of
interest. That can either be specified by the Generator 1 settings, the peak as measured on the left channel or

a user-specified frequency.

THD+M Cptions

Measurement Start Freq: 200 Hz
Measurement Stop Frequency: 20.0kHz

THDYM) Preference

® dB
() Percent

Fundamental Selection
() Use Sig Gen 1 Settings
(@) Use Left Peak

() Use Frequency: |1.00 kHz

Cancel

The settings you have picked for Fundamental Selection will result in a small green “F” on the display as shown
below. This makes it easy to know if your fundamental has been correctly determined or not.
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1000
Frequency (Hz)

Generators
The Generators control group is show below:

®@  GENERATORS

From this group, we can select one of four modes of operation. (Sine Gen, Multitone, White Noise and Expo
Chirp). Overall, the QA40x has 5 modes of operation, as shown in the block diagram below. The fifth mode of
operation (“User Provided”) is a programming mode that isn’t accessible from the front panel.
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Sine Generator |
| of B Mux

_ Analyzer Output Block Diagram

Sine Generator 7

Multitane Sine DAC Dutput BNC OUTRUT

—— 0/10/20/30 dB

Attenuator

Y+

White Noise

Expo Chirp

User Provided

T

As the block diagram above shows, the Sine mode allows one or two Sine generators to be active, each with
full control over frequency and amplitude. The dual tone is useful for IMD measurements.

The Multitone sine mode allows dozens or even hundreds of sines to be generated, with each sine having the
same amplitude and related to the neighboring sines. The “density” of the sines is selected by specifying the
number of sines per octave.

White noise results in a purely random output. On a FFT display, where all frequency bins are of equal value,
this will yield a flat spectrum. Pink noise used to be commonly used, because pink noise results in a flat display
when your bin widths vary (higher frequency bins are wider than lower frequency bins). This was common on
Real Time Analyzers, where the topmost bin covered 10 kHz to 20 kHz, the next highest bin covered 5 to 10
kHz, etc. But with modern FFT analyzers, white noise is preferred.

Expo Chirp results in a tone that is exponentially swept in frequency, from 20 Hz to Nyquist. The exponential
nature means you spend more time at lower frequencies, and less time at higher frequencies. But your energy
per Hz is the same.

Sine Generation

The context menu for the sine generators is shown below. Here you can specify the target frequency, and
whether to “round” the frequency. If you opt to round (which is preferred), then the frequency you specify will
be nudged by a fraction of a Hz to ensure it falls into the center of an FFT bin. This will give you more accurate
amplitude measurements.

You can also specify the amplitude in your current Y-axis units you have chosen (see the dBV context menu).

Other options allow you to mute the left or right output. This is helpful if you are wanting to understand the
peak power output of an amplifier with just a single channel active. You can also set the sensitivity for the
AMP1 and FREQ1 and AMP2 and FREQ2 adjustment knobs that are also in this control group.

If you check the “Use Hz” box, then your frequency adjustments will be based on the Freq Knob Sensitivity
value you specify. If the “Use Hz” box is unchecked, then the frequency adjustments will be made based on the
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Octave sensitivity you specify. So, if you are at 1 kHz, and you have specified 1 octave, then each click of the
FREQ1 UP button will result in changes that step 1 kHz, 2 kHz, 4 kHz, 8 kHz, etc.

If the “Use Hz” is specified and you have checked 1 kHz, then each click will result in changes that step 1 kHz,
2 kHz, 3 kHz, etc.

Signal Generator Settings

Frequency and Amplitude

Freguency:

Round to eliminate leakage

Amplitude (dBV): |-10.00

Note amplitude units are always the cument YAxis units.
Other Options

Freq Knob Senstivity (Octaves): | 1/2 ~

Freq Knob Sensitivity (Hz): |1.00 kHz

Use Hz []

Amplitude Knob Sensitivity (dB):

Cancel

Multitone

The multitone context menu is shown below. Here you can specify the number of tones per octave. For

example, if you specify 1 tone per octave, then the output will have a sine placed at 20 Hz, 40 Hz, 80 Hz, 160
Hz.

Multitone Settings

Tones per Octave |5 =

Total RMS Level (dBV): (5000

Cancel

The total RMS level is the RMS you would expect to measure from 20 to 20 kHz. Be aware the numbers can

grow very large very fast. For example, if you specify 10 tones per octave and 0 dBV output, you will get the
following:
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Sys:FFT = X |Sys:GenMulti = X |L:RMSdBV = X
Multitone
256k Multione -0.03 dBV

‘ | | ) ‘

SRR MR [

1000 10000
Frequency (Hz)

Notice above that while we have 0 dBV total RMS, each sine is about -20 dBV. The sum of all these sines,
however, is around 0 dBV. But the real challenge is in the time domain. Notice that even though each sine is
just 100 mV in amplitude, the total output level has exceeded 4V peak in places. Be aware of the demands you
are placing on the DUT with multitone testing. It is very easy to clip your DUT when using multitone.
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2.000000 4 000000 5.000000
Time (second)

White Noise

White noise generation doesn’t have a context menu. It’s simply a stream of random numbers where the RMS
measured will usually match the RMS you have specified. Sometimes the RMS will be a bit higher, other times
a bit lower.

Expo Chirp

The context menu for Expo Chirp is shown below. Here you can specify the level of the chirp. The options also
allow you to specify Windowing on the captured chirp. Windowing truncates captured portions before and
after the peak of the captured impulse response. For most measurements, you’ll want this at 0, which means
windowing is disabled. But for acoustic measurements, some additional processing is done when windowing is
non-zero:

1) A complex division is done between the output waveform over the input waveform. This yields the
frequency response

2) Avreverse FFT is done on the complex division to arrive at an impulse response.

3) The peak of the impulse is determined. For the 1 mS prior to the peak, a Half Hann window is applied.

4) For the user-specified period after the peak, a Half-Hann window is applied

Thus, windowing allows you reject signals that arrived late due to room reflections. Since sound travels at
roughly 1 foot per millisecond, you can effectively filter out late-arriving reflections by specifying a window
that is less than your expected round-trip reflection time. But be aware that short windows result in
compromised measurements at lower frequencies. The topic of acoustic measurements and windowing is well
covered on the internet.
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Frequency Response Settings

Stimulus Settings
Stimulus: | ExpoChirp e
Amplitude (Dbv):  [-12.00

Expo Chirp Cptions

End Frequency: 24000

Octaves: 8
Window (mS): 0.0 H m= disabled)
Smoothing (Octaves): | Mone it

Use Right Channel as O
Reference

Hamonic Display

Mask Settings

Freq Response Mask | Load Clear
Display Pass/Fal []

Cancel

Smoothing is specified in octaves and can be applied to the spectrum before it is displayed.

You can also specify you'd like to use the right channel as the reference. This is a handy technique for removing
frequency impacts that are common to the ADC and DAC paths of the analyzer, and thus what remains is just
the DUT impact on the frequency.

See more discussion on this topic at the QA40x Wiki.

If you have a mask file prepared, you can load the mask file and opt to display a pass or fail message if the
frequency response deviates outside of the mask limits. Mask files are very simple to create. An example:

# QuantAsylum Mask File

# Frequency, Minimum Pass Value (dB), Maximum Pass Value (dB)
100, -1.0, 1.0

20000, -1.0, 1.0

If you load the mask into the Mask Settings and then enable the display of Pass/Fail, you will see the following
if the trace is completely inside the mask:
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| NI
\

1000
Frequency (Hz)

If the measured response is within the mask boundaries, you will see PASS displayed, and FAIL display if not.
Masks can be as complex as required to capture the expected behavior. You can create them manually, as
above, or use an automated measurement to export a mask.

Full Scale Input

Full Scale Input determines the maximum input before clipping will occur. Note that the maximum input to the
analyzer is +32 dBV, with a max DC of 40V and a max ACpeax + DC of +/- 56V. Those limits must always be
respected, even if you are on the +42 dBV input range. The concept of full-scale input is to help the engineer
understand how far away they are from clipping, as this has an impact on the measurement quality.

The full-scale input control group is shown below:

FULL SCALE INPUT @

BN ENEN 2

A\ VAXINPUT: +37 4BV = 4OVRMS MAXDC =40V MAX ACsy + DC = :5BV

Note that for level 24 dBV and greater, the attenuator is active. The attenuator is a hardware divider at the
front-end of the analyzer that attenuates the reduces the signal by 24 dB. When the input attenuator is active,
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the input sees a higher source resistance which will manifest as higher input noise due to the current noise of
the input opamp.

You can click on the “?” graphic to learn more about the preferred input ranges.
Run/Stop

The Run/Stop control group allows you set sample rates, start and stop acquisition, define idle mode behavior
and control the front-panel 12S operation.

RUN/STOP

The sample rate can only be changed while acquisitions are stopped. Changing sample rates will result in a
reset of the converters which might cause a slightly pop on the outputs. If you are working on high-gain circuits,
this might manifest as large output changes during sample rate changes. In general, the performance of the
converters is better at lower sample rates. If your measurement task doesn’t require frequencies beyond 20
kHz or so, stick to the 48K sample rate.

Click or press the “Press to Run” button to begin acquiring data. You can click it again to stop acquisitions.
There is a context menu associated with this button that will be discussed more below.

The Idle button will generate a constant sine at the Gen1 settings when the analyzer is NOT acquiring data. This
can be useful if you want to verify a lineup with a DVM. By default, when the analyzer isn’t acquiring data, the
outputs are muted.

The front panel I12S allows you to test 12S devices. The pinout of the front panel connector was shown
previously. The context menu here allows you to set operating parameters for the 12S, including bit depth and
sample rate.
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a5 Front Panel 125 Settings et

Front-Panel |25 Must be Stopped to Make Changes

Bit Depth | =2 bits i
Sample Rate 48kSP3 ocked)

The front-panel 125 can generate single and dual{one
sines, depending on the settings in the GENERATORS
section. The amplitude of the 125 is adjusted using the
GEMERATORS amplitude settings, with 0 dBY mapping to
0 dBFS. Amplitudes in excess of 0 dBY will result in [25

clipping.

Ppply

Run/Stop Context Menu
The context menu for the Run/Stop button is shown below.

Triggered Acquisition
The Triggered Acquisition is discussed in more detail on the QA40x Wiki article Triggered Sweeps.

g5l Acquisition x
Triggered Acquisttion  Cross-Comelation  Audition

Triggered Acquisition

Triggered acquisition is a specialized type of test where the DUT will play a
modffied log-chim waveform asynchronoushy. That waveform will be captured by
the analyzer. To create the modified log-chirp, adjust your FFT size as desired, and
then use the File->Export-»Export Chimp to export the WAY. That WAV can then be
moved to a USE memary stick or uploaded to the cloud, etc and then played on
the DUT.

Left Channel Level

Start Left Channel Trigger Level (dBY) |22 =
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In short, this mode is useful for DUTs that do not have an analog input. By playing a special WAV exported from
the QA40x application, you can trigger a sweep and learn the frequency response from of the DUT using a
chirp.

Audition

Audition allows you to play back a WAV file. The settings are shown below. The WAV file is loaded into RAM,
and then playback begins at the volume level specified. The output attenuators can be locked to the specified
full scale. For example, if you specify +18 dBV output attenuator, then a 0 dBFS signal will be +18 dBV. And if
you specify the +8 dBV output range and a -20 dBFS volume, then the max output will be -12 dBV.

gt Acquisition >
Triggered Acquistion Cross-Comelation  Audition
Audition
This allows you to load and play (" Audition ) a wave file through the Anabyzer
hardware. This can be useful if you are testing an amplifier and want to interact

with tone knobs or effects. The WAV file must be at the cument sample rate AND
mugt be 24b int or 32b float stereo.

Load File

Start Playback Violume (dBF5) 20 =

Stop Playback
DAC Full Scale | #18dBV

Cursors
The cursor control block is shown below:

LURSORS

You can add one or two cursors to your measurement, and each cursor can be associated with either the left
or right trace. Cursors can remain off screen as you pan looking for events in the data. To bring them back on
screen quickly, the Center button will snap the cursor to the center of the current display window. The Left and
Right buttons allow you to associate the cursor with the indicated channel. And the Peak button will slightly
nudge the cursor onto a nearby peak.

A legend will be shown in the lower left of the display, including delta’s for each measurement:
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1000
Frequency (Hz)

The cursors also work in the time domain, and the legend will also show 1/period allowing you to quickly learn
the frequency at a given point in time.
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0.067000 0.068000

0.069000

Other Items
Soft Keys
There are several useful softkeys that can accelerate workflow:
Key Function
“Space” Starts or stops acquisitions
“ctrl+space” Runs a single acquisition. This can be useful if you are conducting a “smoke test”
on a very high power amplifier. By selecting a very small FFT, you can emit a single
short burst of sine. For example, a 1K FFT at 48Ksps will result in a 20 mS burst of
signal. Emitting a single one of these bursts can be helpful as you are trying to
learn the limits of operation.
“r” This is cut FFT size in half.
(open bracket)
“1” This doubles FFT size.

(close bracket)

//I ”

Enables idle-tone generation.

“D” Deletes all markers
“Page Up” Scrolls control panel up quickly (Page Up) or slowly (Up Arrow)
“Up Arrow”

“Page Down”

Scrolls control panel down quickly (Page Down) or slowly (Down Arrow)
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“Down Arrow”

“F3” Re-runs the last automated test

“r” Displays (or hides) left trace

“R” Displays (or hides) right trace

“X” Toggles Log versus Linear display in frequency mode
“1”7 Toggles Gen1 on or off

“2” Toggles Gen2 on or off

Command Line Options
The following command line options are available for the QA40x application:

-L Enables logging to a file name comprised of the date and time, and placed into
the directory “MyDocs\QuantAsylum\QA402\Log directory”
-C Enables console display

Automated Tests

The Automated Test menu items allows many tests to be completed automatically, based on parameters you
enter. Descriptions of the available automated tests can be seen from the webpage linked below while the
QA40x application is running. When you click on this link, the QA40x application will generate a web page of
all available tests, including descriptions of each parameter.

http://localhost:9402/AutomatedTests

Visualizers
Visualizers are tools that can provide additional insight into the raw data. The current Visualizers allow analysis
of wow and flutter and also residual distortion.

Remote Control and APIs

The QA40x application can be controlled by a very power REST interface without needed any additional DLLs
or library, and it can be supported by just about any language that is capable of loading a web page. See the
QA40x_Wiki for more information on controlling the QA40x application and hardware from your own
application. The linked page also includes information on test applications, and some simple examples for
Python.
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